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Important Information1	

This instruction manual describes the installation, configuration and use of the Motion Manager 4 
software from FAULHABER.

Please read through the complete instruction manual before using the software.��

Keep this instruction manual in a safe place for later use.��

Motion Manager 4 is 32 bit software for PCs with Microsoft® Windows® operating system.��

FAULHABER is not liable for any data loss, damage or other problems which arise due to use of ��
this software.

Symbols used in this instruction manual1.1	

NOTE Note
This “Note” pictogram provides tips and recommendations for use and handling of the program.



6

Important Information1	
Safety instructions1.2	

Compliance with the following safety instructions is a precondition for working with FAULHABER 
Motion Manager 4. You should therefore carefully read through all instructions and follow them 
when using the software.

Intended use
The FAULHABER Motion Manager 4 is designed for the configuration and putting into service of 
FAULHABER drive controls.

Depending on the models concerned, the controls to be configured can be connected to the PC via 
various interfaces. Depending on the control's features a programming adapter will also be required, 
which is available from FAULHABER on request.

The Motion Manager 4 software is designed for the following tasks:

	Configuring the device functions and the drive parameters with the help of graphic dialogs��

	Operating the devices via serial RS232, USB or CAN interface��

	Command input with plain text support��

	Creating, transferring and managing sequential programs and parameter files��

	Dynamic setting of the controller parameters��

	Graphic online analysis of the drive's performance��

	Creating and executing simple program sequences with the help of VBScript��

NOTE
The functions listed above are not available in all controls and depend on the features of the respec-
tive control to be configured.

The following controls are supported:

3564K024B CS��

MCBL 3003/06 S��

MCDC 3003/06 S��

3564K024B CC��

MCBL 3003/06 C��

MCDC 3003/06 C��

3564K024B C��

MCBL 2803/05��

MCDC 2803/05��

MCLM 3003/06 S��

MCLM 3003/06 C��

SC 1801��

SC 2804��

SC 2402��

BX4 SC��

BX4 CS��

BX4 CSD��

BX4 CC��

BX4 CCD��

The following interfaces are supported:

Serial RS232��

CAN (by default interfaces from IXXAT)��

Additional supported interfaces:

ESD•	

EMS•	

USB (for Speed Controller)��
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Description2	
General product description2.1	

Motion Manager 4 software from FAULHABER provides convenient access to the settings and  
parameters of the connected motor controls.

The graphic user interface can be used to read out, change and reload configurations. Individual 
commands or complete parameter sets and program sequences can be entered and transferred to 
the control. Command responses are logged together with the sent commands in the “History” tab. 
In addition, analysis options are available in the form of status displays and graphic trace windows.

Communication with the motor control takes place either via a serial RS232, a USB or a CAN inter-
face.

Starting the software

After the software has started the enabled interfaces are opened one after the other and the speci-
fied address range is searched for connected devices (scanning process).

The program interface

Directly after the start the main window is displayed, which is divided into several areas.

NOTE
The program interface is dynamically designed so that the layout of the toolbars and menus match 
the respective connected device. Various functions and commands are therefore not always visible.

The main controls are arranged as follows:

1

9

8

7

6

5

2

3

4

	 1	 Menu bar

	 2	 Quick start bar

	 3	 Command input 
field

	 4	 Node Explorer

	 5	 Status bar

	 6	 Input / Output area

	 7	 “History” tab

	 8	 “File” tab

	 9	 “Upload” tab

Devices found

The devices found are displayed in the Node Explorer (4) after the end of the scanning process.
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Installation3	
System requirements3.1	

The Motion Manager 4 software from FAULHABER has been developed for PC systems with  
Microsoft® Windows® 2000 an higher operating systems installed.

Recommended minimum configuration of the PC system:

Hard disk drive space required: 20 MB��

Installing the software3.2	

The “SetupFAULHABERMoMan4_*.exe” file is required to install Motion Manager 4.

Run the “SetupFAULHABERMoMan4_*.exe” file.��

Confirm the Start window of the installation program by clicking “Next”.��

Read the complete End User licence agreement. If you agree to the terms of the licence agree-��
ment, tick the relevant selection box and confirm your selection by clicking “Next”.

Enter your name and the name of your organisation in the fields provided and then click “Next”.��

If necessary, change the installation path for the software and then click “Next”.��

Use the summary displayed to check the settings made and start the installation by clicking “In-��
stall”.

The installation process is carried out.��

Select whether the software is to be started after installation or not and end the installation by ��
clicking “Finish”.
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Installation3	
Updating the software3.3	

The updating of the installed software version differs depending on the predecessor version.

Updating Version 3.xx or older

An already existing Version 3.xx or older of Motion Manager is not impaired by the installation of 
Motion Manager 4. The two versions can exist alongside each other on the same PC system. In this 
case the installation process is as described in Chapter 3.2 “Installing the software”.

Updating Version 4.xx

If an older version of Motion Manager 4 exists on the system it is updated when a newer version is 
installed.

The “Options” menu item of the “Extras” menu can also be used to activate an automatic online 
update function.

Uninstalling the software3.4	

To completely remove Motion Manager 4, complete the following steps:

Open the “Add/Remove Programs” menu in the Windows Control Panel.��

Select “FAULHABER Motion Manager 4” from the list and click “Remove”.��

Confirm the renewed prompt whether Motion Manager 4 is to be removed or not.��
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Basic Functions4	
Starting the software4.1	

Starting Motion Manager 4 via the Start menu4.1.1	

Following installation the “FAULHABER” group in the Start menu contains the “Motion Manager 4” 
link which can be used to start the software.

Starting Motion Manager 4 with command options4.1.2	

The program file moman4.exe contains various command options which can be used when starting 
the software from the command line or adjusted link.

Example for command line invocation:

C:\Programme\Faulhaber\Motion Manager 4\>moman4.exe /H /RUN:script.vbs /E

Motion Manager 4 is started in the background (ff /H), the script script.vbs is run  
(/RUN:script.vbs) and then the program is exited (/E).

List of the available command options

Parameter Function
/RUN:script.vbs Runs the given Visual Basic Script immediately after the Motion Manager starts.

/E Exits the Motion Manager in conjunction with /RUN: immediately after the script has been run 
through.

/H Runs Motion Manager invisibly in the background.

/ENG Starts Motion Manager with an English user interface, if the English version is installed and Ger-
man is set as the default.

/DEU Start Motion Manager with a German user interface, if the English version is installed.

Example for switching to the German interface if the English version is installed:

C:\Programme\Faulhaber\Motion Manager 4\>Moman4.exe /deu

NOTE The German version contains the German resources only, the English version on the other hand con-
tains both the English and the German resources. It is therefore only possible to switch over  
languages if the English version is installed!

The command options listed above can be given individually or in combination with each other on 
opening moman4.exe (see example).

Automatic scan for connected devices4.1.3	

After starting the software, Motion Manager automatically searches the interfaces selected under 
“Connections...” (see Chapter 4.1.5 “Setting up connections manually”) for connected controls 
within the specified address ranges (scanning area of the node No.). To this end the interface and 
protocol plug-ins selected for each interface are used.

Default connection parameters

Parameter Function
PC interface COM1
Scanning range 0 – 10
Protocol Serial FAULHABER protocol for devices with command interface (e.g. Motion Controller)
Interface Standard serial interface
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Basic Functions4	
Starting the software4.1	

Following completion of the start procedure, all detected controls are displayed in the Node Explorer.

If no control was detected, Motion Manager automatically starts the Connection Wizard.

As an alternative to the Connection Wizard the connection parameters can also be set under “Con-
nections” (see Chapter 4.1.5 “Setting up connections manually”).

NOTE The scanning process can also be invoked manually at any time after Motion Manager has been 
started.

Menu bar - Terminal - Node Searchff

Scan button on the Quick Start barff

“F2” keyff

Connection Wizard4.1.4	

If no connected nodes are found when the Motion Manager is started the Connection Wizard ap-
pears. It helps the user to set up the connection with the connected control.

Step 1: Select the device family

Motion Controller with RS232 interface��

Motion Controller with CAN interface��

Speed Controller without command interface��

Step 2: Setting the connection parameters

Depending on the device family set, the corresponding connection parameters are queried.

Step 3: Summary and completion

The settings made are displayed in a summary for final checking. You can correct incorrect settings 
by clicking the “Back” key. The connection setup is finished with the “Finish” key.

After completion the node is visible in the Node Explorer.

NOTE The Connection Wizard can also be opened manually at any time after Motion Manager has been 
started.

Menu bar - Help - First Steps (Connection Wizard)ff
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Basic Functions4	
Starting the software4.1	

Setting up connections manually4.1.5	

If the connection from Motion Manager to the connected control is to be set up without the Connection Wiz-
ard, this can be done using the “Connections...” function in the “Terminal” menu of the Menu bar.

“Connections” tab

Enabling the required interfaces (serial RS232, 
CAN, USB).

If the serial interface is enabled the ports at 
which controls are connected must also be select-
ed (COM1, COM2, ...).

A tab for setting the respective connection 
parameters is displayed for each enabled inter-
face / port.

NOTE A corresponding driver must be installed to enable access to a Speed Controller with programming 
adapter via USB. The first time the programming adapter is plugged in, the Windows Hardware Wizard 
performs the driver installation process (see quick reference guide of the programming adapter).

“COMx”, “CAN” and “USB” tabs

Connection settings for the respective interface.

Interface plug-in:

Select the DLL file which makes the connection 
between Motion Manager and the interface 
driver.

COMx: Default “Mocom4.dll”��

CAN: As a default, “Ixxat_vci3.dll” is installed ��
for IXXAT CAN interfaces via their VCI3 driver. 
A corresponding plug-in file is required for 
other manufacturers' interfaces or for other 
drivers (e.g. “ems_cpc.dll for EMS-Wuensche 
interfaces).

USB: “SerialDL.dll”��

Protocol plug-in:

Selection of the DLL file with the communication 
protocol of the devices to be addressed.

COMx with Motion Controller: “Dffrsprot.dll”��

COMx with Speed Controller: “Dffscprot.dll”��

CAN with Motion Controller: “Dffcanprot.dll”��

USB with Speed Controller: “Usbscprot.dll”��
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Basic Functions4	
Starting the software4.1	

NOTE It is also possible to use several protocols via one interface as long as no protocol conflicts occur. 
Then when scanning the network, all the given protocol plug-ins are loaded one after the other to 
search for supported nodes.

Transfer rate:

Setting for the speed of the data transfer (baud rate). Please check beforehand whether all devices 
to be addressed at this interface also support the required baud rate.

Scanning range:

Setting the range of the node numbers in which connected devices are to be looked for (no signifi-
cance for FAULHABER Speed Controllers).

Click “OK” to save the settings and automatically search through the selected interfaces. Any con-
trols found are displayed in the Node Explorer.
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Basic Functions4	
The user interface4.2	

The main window of the FAULHABER Motion Manager is divided into different areas (see Chapter 
2.1 “General product description”), which are described in greater detail here.

The Menu bar4.2.1	

The menu bar contains all functions and commands required to use the Motion Manager. Its ap-
pearance is dynamic and depends on the currently selected control so that several functions are only 
available if they are actually supported by the control.

“File” menu
The “File” menu contains the standard functions for creating, opening, saving and printing Motion 
Manager files.

The following file types can be processed with Motion Manager:

Motion Control files �� *.mcl

Motion Parameter files �� *.mcp

Visual Basic Script files �� *.vbs

The “New” menu item deletes the input / output area of the displayed tab.

“Edit” menu
In addition to the standard functions of the “Edit” menu, the “Program File” item can be used here 
to activate program editing mode for several controls.

If this menu item is enabled, commands selected from the Commands menu are not sent directly 
to the drive, but instead are copied into the file editing area where they can be used to create a 
sequential program.

A new toolbar for debugging sequential programs appears above the file editing area (see Chapter 
5.1).

“Terminal” menu
All settings and actions based on the connection with the control can be controlled in this menu. In 
addition, functions for transferring, receiving and comparing program and parameter files are avail-
able for several controls.
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Basic Functions4	
The user interface4.2	

“Commands” menu
This menu is only available if a control with command interface has been selected (see Chapter 4.2.5 
“The Node Explorer”). It contains the most important commands of the connected control. After 
selecting a command and possibly entering a value the command is copied into the command input 
field. From here the command can be sent directly to the control, whereby the node number of 
the selected device is automatically placed in front in network mode (see Chapter 4.2.3 “The Input 
field”). Touch the commands with the mouse and a precise explanation of them appears in the Status 
bar at the bottom edge of the Motion Manager window.

“CAN” menu
This menu is only available if a CAN node has been selected (see Chapter 4.2.5 “The Node Explorer”).

The “CAN” menu contains special functions for operating CAN controls, among other things the 
telegrams for controlling the CANopen state machines (NMT, Device Control) and for motion control, 
access to the CANopen object dictionary or node configuration via the LSS protocol. Any CAN tel-
egrams can also be sent.

“Configuration” menu
The “Configuration” menu contains configuration dialogs for setting drive functions and param-
eters. For example, the following settings can be made here:

General basic settings such as operating mode, connected motor / encoder, etc.��

Drive parameters such as positioning range limits, speed ranges, etc.��

Controller parameters��

Function of the inputs / outputs and definition of a reference run��

Connection parameters of the control such as transfer rate and node No.��

NOTE
The layout of the menus and the dialogs is dynamic and depends on the control to be configured.
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Basic Functions4	
The user interface4.2	

“Analysis” menu
Motion Manager provides the opportunity to display the status of the control (status display) and 
to visualise the control's performance (Graphic Analysis), provided the selected device supports this 
function. See Chapter 5.3 “Analysis”. 

“Help” menu
The “Help” menu contains the reference to this instruction manual, options for contacting FAULHABER 
via its homepage and by eMail, a reference to the Help file of Visual Basic Script, and the option of 
starting the Connection Wizard manually (“First Steps”), see Chapter 4.1.4 “Connection Wizard”.

The Quick Start bar4.2.2	

Like the Menu bar, the Quick Start bar also has a dynamic layout and adjusts to the options of the 
selected control.

The buttons correspond to the respective functions in the Menu bar:

File – New (also Delete the active tab in the input / output area)��

File – Open��

File – Save��

Edit – Copy��

Edit – Paste��

Terminal – Node Search��

Commands – Motion Control – Enable Drive (“EN”)��

CAN – Device Control (DSP402) – Switch on ��

Commands – Motion Control – Disable Drive (“DI”)��

CAN – Device Control (DSP402) – Disable Voltage ��

Commands – Sequential Program – Start Program Sequence��

Commands – Sequential Program – Stop Program Sequence ��

Analysis – Graphic Analysis��

Terminal – Run Script��
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Basic Functions4	
The user interface4.2	

The command input field4.2.3	

The command input field enables the manual input of commands. If the selected control has a com-
mand interface, depending on the “Program File” setting, the entered command can then be sent 
directly to the control or can be copied into the “File” editor window.

In the case of controls with serial command interface the entered text is sent unchanged to the ac-
tive COM port, irrespective of which serial node is selected. In the case of CAN devices the entered 
command is translated into a corresponding CAN telegram in accordance with the set CAN protocol 
with identifier according to the Node No. of the selected device. The CAN telegram is forwarded via 
the set interface plug-in to the driver of the CAN interface card.

The commands can either be entered in the input field manually, or can be selected from the list 
of available commands in the “Commands” menu. If applicable, following a parameter query, the 
selected command is copied into the input field together with the entered value.

The possible commands can be looked up in the command reference of the respective Motion Con-
troller and in Chapter 5.5 “Advanced Motion Manager commands for CAN”.

Program file

Enable the “Program File” function in the “Edit” menu to change the button next to the input field 
from “Send” to “Apply”. Motion Manager then does not send the commands in the input field to 
the control but to the Editor window of the “File” tab in the input / output area.

NOTE When you switchover tabs in the input / output area the “Program File” function is automatically 
disabled. Commands entered in the input field are once again sent to the control.

The Debug toolbar is retained until the file editing area is deleted using “File” - “New”, or you 
switch to another node.

The FAULHABER motor4.2.4	

The image of a cut open FAULHABER motor in the top right-hand corner of the Motion Manager 
window shows the activity state of the selected control. After entering a command sequence for acti-
vating the control the motor begins to turn. If the control is disabled the animation does not move.
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Basic Functions4	
The user interface4.2	

The Node Explorer4.2.5	

The Node Explorer displays all the controls found with which Motion Manager was able to success-
fully set up a connection. The display is divided into three hierarchies:

Interface (COMx / CAN / USB)��

Node No.��

Drive and control��

NOTE
If the interface symbol is crossed out in the Node Explorer display the set interface is not available 
(e.g. blocked by another application, not available or an incorrect CAN driver has been set).

Selecting a control

The control whose settings are to be edited is selected by double-clicking the corresponding node. 
The active node is displayed in bold and with a motor symbol.

Tool Tip

If you move the mouse cursor in the Node Explorer window a Tool Tip box appears briefly with fur-
ther info on the selected node and the set interface parameters.

The Context menu

Click the right-hand mouse button (“right-click”) on the window of the Node Explorer and a Con-
text menu appears for controls with command interface; this Context menu makes various functions 
available depending on the control selected.

For example:

Display info about the selected node, e.g. Firmware version and Serial No. (Node Info)��

CAN functions according to CAN menu��

NOTE The Speed Controllers cannot respond to Scan Commands. Therefore the corresponding node ap-
pears in the Node Explorer permanently, if this control type is set, irrespective of the presence of a 
connected control or not.
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Basic Functions4	
The user interface4.2	

The Input / Output area4.2.6	

The input / output area is divided into three tabs, each of which contains a Text Editor window.

History

All commands sent and all data received is displayed in the “History” tab of the input/output area. 
Received data is shown in italics. The corresponding CAN telegrams are displayed for CAN commands 
(not for FAULHABER commands which are transferred via the FAULHABER channel).

NOTE
Feedback responses from FAULHABER commands for CAN drives (OK or errors) are displayed if the 
transfer type of PDO2 in the drive is set to asynchronous (SOBJ 1801 02 FF).

File

The “File” tab can be used to write your own program files or scripts. Files created here can be sent 
to the control (sequential programs) or can be executed on the PC (VBScripts) and stored locally on 
the PC. Files loaded via the “File” – “Open” command also appear in this tab. In this case the tab 
name changes to the file name.

If program editing mode is enabled, another toolbar for debugging sequential programs is also 
displayed in this tab.
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Basic Functions4	
The user interface4.2	

Upload

If data records are loaded from the control onto the PC (parameter or program files), the data ap-
pears in the “Upload” tab. The data can be edited and saved in the Upload window and transferred 
back to the control.

NOTE
The content of each Editor window in the input / output area can be saved, printed out and deleted 
(“File” – “New”).

The Status bar4.2.7	

The status bar displays the current status of Motion Manager and the selected control. In normal 
status, if none of the buttons are touched with the mouse cursor, the display is divided up as follows:

Currently selected nodes and interface or program editing mode��

Status of the connection��

CANopen NMT status��

Status of the control��

Currently set mode of the control��

NOTE Apart from the layout in normal status the status bar also displays useful information on many but-
tons or commands, if they are touched with the mouse cursor.

Example: Display if the “Commands” – “Sequential Program” – “TIMEOUT” command is touched
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Basic Functions4	
The Configuration dialogs4.3	

Extensive graphic configuration dialogs are available for each device group, which enable convenient 
drive configuration and parameter assignment (“Configuration” menu or “Configuration” button).

The configuration dialogs are usually divided into several pages. Changes can be made directly on 
the graphic interface and transferred to the drive unit by pressing the “Send” button.

NOTE Note:
The parameter settings possible for each configuration and the function of the individual parameters 
are described in the relevant chapter of the device's operating instructions.

Configuring the Motion Controller4.3.1	

With the Motion Controller the parameter commands of the changed settings are sent. The new set-
ting is then immediately active and is retained until the power supply to the control is switched off.

If the new setting is to be permanently saved, the  
“EEPSAV” button must then be pressed; this causes the current parameters to be transferred into the 
non-volatile memory of the drive unit.

With CAN controllers it is necessary to note that the configuration dialogs are only accessible in 
“Operational”status; therefore, the drive unit must be placed in the relevant status beforehand 
using the CAN-NMT menu (Start Remote Node). The “Basic Settings” tab is available here in FAUL-
HABER mode (OPMOD-1) only, as Faulhaber-specific configurations can be made here, which are not 
supported by the CANopen standard.

NOTE Note:
If a sequential program is running in the control which independently sends data to the serial inter-
face, it must be stopped before opening the configuration dialog to avoid incorrect display values!

Optimization for connected motor
If a new BL motor or linear motor has been connected to the controller, select the correct motor type 
according to the connected motor in the “Basic Settings” tab and send the setting to the drive.

For a motor which is not listed in the motor type list, select “Special Motor” and enter the motor 
resistance RM and the speed constant KN parameters for BL motors and the pole pitch TM parameter 
for linear motors, according to the catalogue details in the displayed fields.

For even better adjustment of the controller to the connected motor, you can optimise the Hall 
sensor signals and the phase angle of the sinus commutation using the corresponding button. The 
motor must be able to run freely for several seconds without load.

Non-optimised Hall sensor signals can result in irregular motor running during the first few seconds 
after switching on and in less accuracy. A non-optimised phase angle results in increased power con-
sumption and as a result to a poorer efficiency.

After pressing the “Optimization for connected motor” button you are guided through automatic 
optimisation of the Hall sensor signals and the phase angle.
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Basic Functions4	
The Configuration dialogs4.3	

After completing the optimisation the determined system parameters then only have to be perma-
nently saved with “EEPSAV”.

If you cannot run the connected motor with maximum velocity in no load because, for example, a 
gear is flange-mounted, it is possible that the automatic setting of the phase angle cannot be used.

For this case it is possible to correct the phase angle manually:

First, set the required output voltage on the relevant page. The setting can be made most accurately 
at 100% (corresponds to 15 000 rpm or no load speed of the drive). With certain connected drive 
units it is however advisable to reduce the value, e.g. so that a maximum gear input speed is not 
exceeded.

In this case, move the slide controller for the phase angle in one direction or the other and observe 
the current value. The phase angle is optimally set at the point where the smallest current value is 
displayed.

After successfully setting this page manually, quit it with “Next”. The Hall sensor signals are then 
readjusted. Finally, run “EEPSAV” again to permanently save the determined system parameters.

Dynamic setting of the controller parameters
Under the menu item “Configuration” - “Controller Parameters...” the controller parameters can be 
changed online using the arrows of the input fields or by entering a value via the keyboard. As soon 
as the value of an input field has changed it is automatically sent to the drive. With keyboard entries 
the corresponding field remains grey until the field is quit or “Enter” has been pressed; only then is 
the value sent to the drive.

This enables dynamic synchronisation of the parameters, similar to the case with a potentiometer.

The controller parameter dialog is a non-modal dialog, which can also be opened alongside other 
windows, unlike the other configuration dialogs, which remain in the foreground until they are 
closed. In this way, e.g., while a graphic analysis is displayed, it is possible to turn the controller pa-
rameters and observe the effect on speed or position stability.

After setting the optimum controller parameters do not forget “EEPSAV” so that the parameters are 
retained even after the control is switched on again!

See also the “Setting the Controller Parameters” chapter in the Motion Controller Instruction 
Manual.

Configuring the connection parameters
The menu item “Configuration” - “Connection Parameters...” can be used to set the transfer rate 
and node No. of a connected drive unit.

Motion Controller with serial interface

If a connection has not yet been made with a drive node, the transfer rate set in the drive is deter-
mined when the dialog is started by scanning all possible baud rates. However, this is only possible if 
one drive only is connected to the serial interface.

If the set baud rate has been determined it can also be changed here and a new node No. set for 
network operation.

For operation in a network it is important that none of the node addresses are assigned more than 
once and that all nodes operate with the same transfer rate!
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Basic Functions4	
The Configuration dialogs4.3	

After pressing the “Send” button the serial interface is opened again with the transfer rate set here 
and is scanned for drive nodes.

Here too “EEPSAV” must be run to permanently save the connection parameters!

Motion Controller with CAN interface

Transfer rates and the node address for the CANopen drives of FAULHABER are set here in accord-
ance with the LSS protocol (Layer Setting Services and Protocol) according to CiA DSP305 V1.

This protocol offers two configuration options:

a.)	Switch Mode Global:

All connected LSS slaves are placed in configuration mode. The baud rate and node ID (node ad-
dress) can only be set if one LSS slave only is connected.

b.)	Switch Mode Selective:

Precisely one LSS slave, whose Vendor ID, product code and serial No. are known, is placed in 
configuration mode. This mode can be used to configure individual drives in the network via their 
serial No.

An additional dialog is available for selecting the LSS mode, via which either an individual node can 
be configured globally or a node whose LSS data (vendor ID, product code and serial No.) are given 
in the following, can be configured selectively.

If an already configured node selected via the Node Explorer is to be reconfigured (e.g. other node 
No.), its LSS data is displayed directly so that the details then only have to be confirmed with “OK”.

If an unconfigured node (Node ID = 0xFF) is to be configured in the network, the vendor ID and the 
product code are already filled, the serial No. of the required node still has to be entered. If only one 
drive is connected, Global mode can be selected, for which no other data must be entered.

NOTE It must be noted that a connection with the Motion Controller can only be made if it is either set 
to AutoBaud or it is set to the same baud rate as the Motion Manager. For this reason the current 
setting should always be properly documented so that the stored transfer rate does not have to be 
determined at a later time by trial and error!

Apart from the vendor ID, the product code and the serial No., the LSS protocol also requires a revi-
sion number. But this number is not used by FAULHABER Motion Controllers in the LSS protocol, 
therefore Motion Manager always transfers “0.0” here and the user does not have to make any 
entries!

After a connection has been set up with the required node you can change the transfer rate (fixed 
transfer rate or AutoBaud) and the node No.

After sending a new configuration it is saved in Motion Controller, which then performs a reset. The 
Motion Manager then uses the set or new transfer rate to scan the network again and the new con-
figured drive nodes should now be correctly displayed in the Node Explorer.
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Configuring the Speed Controller4.3.2	

In the case of the Speed Controllers the configuration change is made via a firmware download.

To check the effect of the change immediately, after downloading the “Run” button can be pressed, 
which switches the drive unit from configuration mode to operating mode. No configuration chang-
es are possible in operating mode. To make new changes the “Stop” button must be pressed, which 
switches the drive unit back into configuration mode.

The control can only be switched to configuration mode after the power supply has been switched 
on. If the connection is interrupted during the configuration, use “Run” / “Stop” to switch back to 
configuration mode.

If the configuration dialog is quit, the drive unit is also placed in operating mode and immediately 
starts with the set configuration. If the drive is not to be started immediately the power supply must 
be switched off first.
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Sequential programs5.1	

Functions are available for editing, transferring, debugging and managing sequential programs for 
Motion Controllers which support the saving and running of sequential programs.

Loading an existing program sequence

Existing program sequences can be loaded in the File Editor window via “File” – “Open...”.

File format

The Motion Controller files have the default extension *.mcl. However, files created with any text 
editor can also be read in as the mcl files are saved in ASCII format.

Creating a sequential program

To create a new sequential program, select “Program File” from the “Edit” menu or click the “File” 
tab in the input / output area.

The code can now be entered. If program editing mode is enabled (“Edit” – “Program File” menu), 
which can be recognised by information in the status bar on the bottom left-hand side or by the tick 
in front of the menu item “Edit” – “Program File”, the commands from the “Commands” menu can 
be copied directly into the program code (“Send” button changes to “Apply”). In addition, a new 
toolbar for debugging and transferring sequential programs appears at the top of the file edit area.

Syntax explanation

Each line contains a command, some followed by a number as an argument (e.g.: LA1000).��

Spaces at the beginning and between the command and argument are ignored. Alphanumeric ��
characters only are sent.

In addition to the commands, comments can also be entered. Comments are introduced by a semi-��
colon (;) and can be positioned at the end of a command line or in a separate line 
(e.g.: HO ;Define Home Position).

Comments are not sent to the drive, they are only used to document the program stored in the ��
PC.

Each letter and each number in a line of the program is sent to the Motion Controller up to the ��
appearance of a semi-colon. The Motion Controller saves the program line, provided it is a valid 
command.

The “PROGSEQ” and “END” commands do not have to be entered as they are automatically sent ��
by the “Transfer program file” function.

To quit program editing mode, select the menu item “Edit” – “Program File” again or switch to the 
“History” tab. Commands can now be sent directly to the drive again (“Apply” button changes back 
into “Send”).
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Sequential programs5.1	

Transfer sequential program to the control

The entered or loaded program can be sent to the control by using the menu item “Terminal” – 
“Transfer File...” and then selecting “Sequential Program”.

If the Debug toolbar is displayed the sequential program can also be transferred using the Start but-
ton which also starts the program immediately.

Compare sequential programs

By using the menu item “Terminal” – “Compare Files” and then selecting “Sequential Program” it is 
possible to check the program code of the File Editor window with the program code stored in the 
control to see whether they are the same or not.

If the sequential program is transferred using the Debug toolbar, the program is automatically com-
pared with subsequent syntax error display before the program is started.

Load sequential program from the control into Motion Manager

A sequential program stored in the control can be transferred to the Motion Manager using the 
menu item “Terminal” – “Receive File” and by then selecting “Sequential Program”. The program 
code is then displayed in the “Upload” editor window and from here it can be edited, saved, printed 
out and also transferred again.

Start sequential program

After the program has been sent to the control it can be started via the “ENPROG” command or by 
clicking the “Start Program Sequence” button (see Chapter 4.2.2 “The Quick Start bar”).

If the sequential program is transferred using the Debug toolbar the program starts automatically.

Debug sequential program

In program editing mode (menu item “Edit” – “Program File” enabled), an additional toolbar is 
available in the File Editor window for debugging the sequential program:

Transfer and execute sequential program��

After the transfer the sequential program is first read back again and checked that it is the same. 
If there are any syntax errors, the command line entered cannot be interpreted by the Motion 
Controller and the faulty program line is then displayed in the Editor window in red. Following er-
ror free transfer of the program the whole File Editor window is displayed grey. In this status the 
program runs on the controller and debug mode is enabled.
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Hold sequential program��

If the program is running in debug mode, this button can be used to interrupt the running pro-
gram. The current program line is then displayed in green in the Editor window.

Stop sequential program��

If the program is running in debug mode, this button can be used to quit the program and the 
debug mode. The File Editor window switches back to Edit mode and changes can once again be 
made to the program code.

Single step.��

The displayed sequential program is transferred to the Motion Controller and is compared. Fol-
lowing error free transfer of the program the whole File Editor window is displayed in grey and 
the first program line is displayed in green. The sequential program is now in the displayed pro-
gram line and can be moved forward by one program step each time the button is pressed.

NOTE
Examples of sequential programs are provided in the installation directory under 
\Motion Manager 4\Examples.
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Parameter files5.2	

In addition to the file functions for sequential programs, there are also functions for transferring, 
receiving and comparing parameter files and for the complete configuration of parameter file and 
sequential program.

Loading an existing parameter file

Existing parameter files (with and without sequential program) can be loaded in the File Editor win-
dow via “File” – “Open...”.

File format

The Motion Controller parameter files are text files and have the default extension *.mcp.

Transfer parameter file

A loaded parameter set can be sent to the control using the menu item “Terminal” – “Transfer Pa-
rameter File” or “Terminal” – “Transfer File...” and by then selecting “Parameter File”.

If a configuration file is loaded with program sequence and parameter listing, this can be transferred 
by selecting “Parameter File with Sequential Program”.

Receive parameter file

By using the menu item “Terminal” – “Receive Parameter File” or “Terminal” – “Receive File...” and 
then selecting “Parameter File” or “Parameter File with Sequential Program” it is possible to create 
an image of the drive configuration stored in the control.

The parameter configuration read in (with and without sequential program) is then displayed in the 
Upload Editor window, from where it can be edited, saved, printed out and transferred again.

Compare parameter file

By using the menu item “Terminal” – “Compare Parameter File” or “Terminal” – “Compare File...” 
and then selecting “Parameter File” or “Parameter File with Sequential Program” it is possible to 
check whether the loaded configuration file is the same as the control's current configuration.

Edit parameter file

Before saving, comments can be added to parameter files for documentation purposes, as described 
in Chapter 5.1 under “Syntax explanation”.
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Analysis5.3	

Under the “Analysis” menu the Motion Manager provides two options for displaying the current 
status of the control and connected motor.

Status display5.3.1	

The status display can be started via the “Analysis” – “Status Display” menu, provided the selected 
control supports this function.

Changes to the listed values are identified by showing and hiding the tick in front of the value 
names. The display is updated every 500 ms

Graphic analysis function5.3.2	

The graphic analysis function of Motion Manager provides numerous options for monitoring and 
evaluating the performance of the drive, provided the selected control supports this function. One 
possible application is the assessment of the dynamic performance of the motor and control or opti-
mising the controller parameters (inclusion of step responses).

The analysis is started via the “Analysis” – “Graphic Analysis” menu or the corresponding button in 
the Quick Start bar (see Chapter 4.2.2 “The Quick Start bar”).
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The “Trace” menu

The “Trace” menu contains all available settings for the analysis function.

Start: Starts the recording of the set values.��

Stop: Stops the recording.��

Settings: Opens the dialog with setting options for signal triggering and data buffer.��

Scaling: Contains the options for the scaling setting of the two Y axes and the X axis.��

Auto Capture: Moves the offset of one or both curves so that they are visible in the display win-��
dow. The scaling is not changed (not available with automatic scaling).

Zoom: Enables / Disables Zoom mode. If Zoom mode is enabled the content of the display window ��
can be moved with the mouse, or enlarged if the Shift key is pressed.

Save: The currently displayed curve can be optionally saved graphically as a bitmap or as an ASCII ��
table in text form. An ASCII table can for example be read into mathematics or spreadsheet pro-
grams for further processing.

Print: The currently displayed curve can be printed out.��

The Toolbars
The toolbars in the main window of the graphic analysis enable direct access to the selected menu 
items.

“Scaling” toolbar

The buttons correspond to the respective functions in the Menu bar:

Trace – Start��

Trace – Stop��

Trace – Scaling – Automatic (Y1)��

Trace – Scaling – Y1+��

Trace – Scaling – Y1–��

Offset setting for Y1 (cannot be reached via the menu)��

Trace – Scaling – Automatic (Y2)��

Trace – Scaling – Y2+��

Trace – Scaling – Y2–��

Offset setting for Y2 (cannot be reached via the menu)��
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Trace – Scaling – Automatic (X)��

Trace – Scaling – X+��

Trace – Scaling – X–��

Trace – Zoom��

Trace – Print��

“Data Sources” toolbar

The toolbar contains two list boxes, from which the data sources for curves 1 and 2 can be selected.
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The FAULHABER Motion Manager enables simple sequential programs or automation scripts to be 
created and run on the PC within the Motion Manager.

The Visual Basic Script Code entered is run via the Microsoft Scripting Host (integrated in Windows 
from Internet Explorer 3).

Creating the script program5.4.1	

Script programs can be created or loaded in the file window and usually have the extension 
“*.vbs”.

Script programs always begin with “SUB MAIN” and end with “END SUB”. The Visual Basic Code can 
be written within this identifier.

NOTE
An explanation of the VBScript command set is given in the Microsoft Help for Visual Basic Script.

Motion Manager functions5.4.2	

In addition to the VBScript command set there are special Motion Manager functions for exchanging 
data with the Motion Controllers. These functions are explained in the following and must always be 
invoked with the object identifier “MC.”:

MC.SendCommand(STR command)
Sends an ASCII command to the Motion Controller

command: String which is to be sent to the Motion Controller.

Example:

MC.SendCommand(“V100”)

STR answer = MC.WaitAnswer(long timeout, long answ)
Waits for the given time in milliseconds for an answer from the Motion Controller.

answer: String sent by the Motion Controller.

answer = ““: No answer after timeout.

timeout: Integer value in ms, by which answer must be received.

answ:  Integer value for extended details of the data to be read in.

answ = 0: Notify commands (“p”, “v”, “h”, etc.) and acknowledgements (“OK”, etc.) are 
filtered out.

answ = 1: All answers are read in except of acknowledgements.

answ = 3: CAN answers in integer format.

answ = 4: Notify commands only are filtered out (acknowledgements are read in).

Example:

a = MC.WaitAnswer(1000,0)
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MC.WriteToHistory(STR text)
Writes the given text line into the History window of the Motion Manager.

text: String which is to be output in the History window.

Example:

MC.WriteToHistory(“Position 1 has been reached”)

MC.SendProgFile(long nodeadr, STR file name)
Sends the given sequential program to the Motion Controller with the relevant node address.

nodeadr: Integer value which gives the node address of the drive to be addressed.

nodeadr = -1: Program is sent to all connected nodes.

filename: String which gives the file name of the drive program, possibly with path.

Example:

CALL MC.SendProgFile(0,”progr.mcl”)

long ret = MC.CompareProgFile(long nodeadr, STR filename)
Compares the sequential program in the Motion Controller of the corresponding node address 
with the program from the given file.

nodeadr: Integer value which gives the node address of the drive to be addressed.

nodeadr = -1: Read in command is sent unaddressed.

filename: String which gives the file name of the drive program, possibly with path.

ret: Integer return value.

ret = -2: Error while reading in the drive program

ret = -1: Motion Controller is not answering

ret = 0: Files are identical

ret = 1: Files are not the same

Example:

ret = MC.CompareProgFile(0,”progr.mcl”) ’Compare program file with MC program

IF ret = 1 THEN

MsgBox(“Programs not the same !”)

ELSEIF ret = -1 THEN

MsgBox(“No answer from Motion Controller !”)

END IF
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MC.SendParamFile(long nodeadr, STR file name)
Sends the given parameter file to the Motion Controller with the relevant node address.

nodeadr: Integer value which gives the node address of the drive to be addressed.

nodeadr = -1: File is sent to all connected nodes.

filename: String which gives the file name of the parameter file, possibly with path.

Example:

CALL MC.SendParamFile(0,”para.mcp”)

MC.SetBinMode(long mode1, long mode2)
Sets binary send mode for Parameter 1 and 2, in order to simultaneously read in up to two vari-
ables via the binary interface of serial Motion Controllers. In CAN controllers Trace mode is set 
here.

mode1: Integer value which gives the send mode for Parameter 1.

mode2: Integer value which gives the send mode for Parameter 2.

Available values for mode1 or mode2 (for further Trace parameters see documentation of the 
relevant Motion Controller):

0: Actual velocity [rpm]

1: Command velocity [rpm]

2: Controller output [integer]

24: Motor current [mA]

200: Actual position [Long]

201: Command position [Long]

44: Housing temperature [°C]

46: Coil temperature or Mosfet temperature [°C]

255: mode2 only -> Parameter 2 is not to be sent
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long ret = MC.BinRequest(long timeout)
Data request. Reads in the parameter set with SetBinMode at the current time with time code. 
The results can be read in via the properties

long MC.BinVal1, long MC.BinVal2, long MC.BinTimecode.

The Timecode value corresponds to a multiple of the time base used by the Motion Controller (see 
Instruction Manual of the respective control) and defines the time interval until the last transmis-
sion (send) (value between 1 and 31).

BinVal1 and BinVal2 are the results of mode1 and mode2.

ret: Integer return value.

ret = 1: Data received

ret = 0: No data received within the timeout time

timeout: Integer value in ms, by which answer must be received.

Example:

CALL MC.SetBinMode(0,1)  ’Read in actual and command velocity

IF MC.BinRequest(500) THEN ’Data request

ActualVelocity = MC.BinVal1

CommandVelocity = MC.BinVal2

Timecode = MC.BinTimecode

END IF

MC.SendBin(long value)
Sends a binary value to the active Motion Controller.

value: Integer 8 bit value which is to be sent.

Binary values are used for setting system parameters in serial Motion Controllers only and are not 
usually accessible to users.

MC.CloseCom
Closes the currently active communications interface.

long ret = MC.OpenCom
Opens the selected communications interface.

ret: Integer return value.

ret = 1: Interface successfully opened

ret = 0: Error while opening the interface
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MC.CmdExecute(STR command)
Runs the given command at system level. This function can be used, e.g. to start an external pro-
gram.

filename: String which gives the command or file name of the application to be run, possibly 
with path.

MC.UpdateWindows
Forwards queued Windows messages to the relevant window. If this function is regularly opened 
in a script program (especially in waiting loops), other Motion Manager functions (e.g. graphic 
analysis) are also available parallel to script processing. Notify commands are forwarded to the 
History window after this function is opened.

NOTE
Examples of Visual Basic script programs are provided in the installation directory under 
\Motion Manager 4\Examples.

Starting the script program5.4.3	

The script program can be started via the Script button in the Quick Start bar (see Chapter 4.2.2 “The 
Quick Start bar”), via the key combination “Ctrl+R” or via the menu item “Terminal” – “Run Script”.

Cancelling the script program5.4.4	

After starting a script program a dialog appears in which the time until a user cancel option can be 
entered. Before this time has expire there is no access to a running script program.

If the script program runs longer than the given time the following dialog appears:

While the dialog is displayed the script program continues to run. It is now possible to prematurely 
quit the program by pressing the “End” button.

Press the “Continue” button to hide the dialog for the given time - it then reappears.

NOTE It is advisable to set the time until the user cancel option to the value “0” to test a program. This 
means it is possible to cancel the program at any time.

After finishing the program and implementing your own cancel options the value can be increased 
according to the program run time.
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In addition to the FAULHABER commands for the Motion Controller, which can be read about in 
the command reference of the respective device, several advanced commands are available for CAN 
which are implemented in the command interpreter of the protocol plug-in “dffcanprot.dll” in the 
corresponding CAN telegrams. The commands can either be entered directly in the command input 
field or used within a VBScript.

GOBJ: Get Object
Reads an entry from the CANopen object dictionary via its index and subindex.

Input format: NodeNo. GOBJ Index Subindex

NodeNo.: Decimal, Index / Subindex: Hexadecimal

Example: Read out the current status word value (Index 0x6041) of node No. 3

3 GOBJ 6041 00

SOBJ: Set Object
Describes an entry of the CANopen object dictionary via its index and subindex.

Input format: NodeNo. SOBJ Index Subindex Data

NodeNo.: Decimal, Index / Subindex / Data: Hexadecimal (lowest byte value on the right). The 
number of data bytes given must correspond to the type of object entry (Int8: 1 byte, Int16: 2 
byte, Int32: 4 byte). One byte is displayed by 2 hex characters (00 – FF).

Example: Change the maximum velocity (Index 0x607F: max profile velocity [Int32]) of Node No. 3 
to value 500

3 SOBJ 607F 00 000001F4

TRANSMIT: Transmit CAN Data
Sends any CAN telegram directly on a specific identifier.

Input format: TRANSMIT Identifier Data

Identifier: 3-digit hex value (000 – 9FF), Data: Hexadecimal (lowest byte value on the left, cor-
responding to CAN telegram).

Example: Send NMT command “Reset Node” to Node No. 3 

TRANSMIT 000 8103

In the CAN menu or in the Context menu of the Node Explorer with enabled CAN control there is the 
entry “Send CAN command directly”, which opens a dialog via which CAN telegrams can be entered 
and transferred directly (corresponds to TRANSMIT command):

PDOs can also be queried here in that a request (RTR) is sent to the corresponding identifier (“Re-
mote Request” selected).
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NOTE The data must be entered as hex values according to the position in the CAN telegram (byte[0] = 
lowest byte value = left-hand side). Spaces may be entered between the individual bytes (e.g.: 0xAF3, 
input F3 0A).

Further commands for controlling the NMT state machine:

The commands can be entered directly with preceding Node No. and according to the menu entries 
under network management (NMT).

START: Start Remote Node��

STOP: Stop Remote Node��

PREOP: Enter Pre-Operational��

STARTALL: Start all Remote Nodes��

Further commands for controlling the device control state machine:

The commands can be entered directly with preceding Node No. and according to the menu entries 
under Device Control (DSP402).

SHUTDOWN: Shutdown��

SWITCHON: Switch On��

DISABLE: Disable Voltage��

QUICKSTOP: Quick Stop��

DIOP: Disable Operation��

ENOP: Enable Operation��

FAULTRESET: Fault Reset��
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Maintenance6	
Software update6.1	

The respective current version of the FAULHABER Motion Manager software can be downloaded 
from the FAULHABER internet site:

http://www.faulhaber.com/MotionManager

Troubleshooting6.2	

Switchboard: +49(0)7031/638-0

eMail: support@faulhaber.de

Internet: www.faulhaber.com
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Licence Agreement7	

End User Licence Agreement for the Faulhaber

Motion Manager of Dr. Fritz Faulhaber 

GmbH & Co. KG

between

1.	 Dr. Fritz Faulhaber GmbH & Co. KG, Daimlerstraße 23 / 25, 71101 Schönaich, represented by the Directors 
Dr. Fritz Faulhaber, Gert Frech-Walter, Dr. Thomas Bertolini

- hereinafter referred to as “Faulhaber” -

and

2.	 you as the user

- hereinafter referred to as the “Licensee” -

Preliminary remarks:

1. Faulhaber designs miniature and micro drive systems and produces them. Faulhaber has developed the “Faulhaber 
Motion Manager” software (hereinafter referred to as “MoMan”). This enables the control of certain miniature and 
micro drive systems manufactured by Faulhaber to change their configuration and for assigning parameters. Details 
result from the program description of MoMan. MoMan is a standard software product which as such is not adapted 
to the individual needs of individual customers. Faulhaber makes MoMan available to the customer free of charge.

2.	 The Licensee intends using MoMan in their company. The details of this result from Article 2.

This having been explained, the Parties to the Contract conclude the following Licence Agreement

§ 1

Subject of the Contract

(1)	The subject of this Contract is the granting of rights to use MoMan by Faulhaber to the Licensee.

(2)	The components of MoMan are

a)	 the machine-readable object code,

b)	 the user documentation including the program description.

§ 2

Content and Scope of the Rights of Use

(1)	Faulhaber grants the Licensee the unlimited spatial, non-exclusive right for an unlimited time to use MoMan for its 
intended use.
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(2)	For intended use the Licensee shall use MoMan solely for putting into service, changing the configuration and for 
setting the parameters of miniature or microdrive systems manufactured by Faulhaber. “Putting into service” means 
controlling the respective miniature or microdrive systems manufactured by Faulhaber using MoMan for the purpose 
of changing the configuration and for setting the parameters. In the event of such a change to the configuration and 
setting the parameters, the instruction manual of the respective miniature or microdrive system shall always be noted 
and followed and the specifications given there shall be complied with by the Licensee. The Licensee shall not use 
MoMan in productive operation. “Productive Operation” means using MoMan to control the respective miniature or 
microdrive systems manufactured by Faulhaber in the company's on-going operations, alone or in combination with 
other components of an overall system. Such use does not represent intended use of MoMan. The same applies to the 
use of MoMan for controlling miniature and microdrive systems, which have not been manufactured by Faulhaber as 
well as its use to control miniature and microdrive systems, which have been manufactured by Faulhaber but which 
are not listed in the program description.

(3)	The rights to use MoMan do not include, in particular, the right to edit (change) or to distribute without Faulhaber 
drive system. In this case too, MoMan shall only be distributed for no extra charge, in an unchanged form and subject 
to enclosure of this License Agreement. The Licensee is not entitled to demand that Faulhaber issue the source code 
or the source code documentation of MoMan. The Licensee is also not entitled to assign the software, the documenta-
tion or parts thereof to third parties by way of rental or leasing for a limited time. Third parties are also deemed to be 
companies within the Licensee's Group.

(4)	Otherwise, any further use of MoMan, especially the transfer of rights of use to third parties or the granting of sub-
licenses, shall require the prior explicit and written consent of Faulhaber.

	 This does not apply to sale of the miniature and microdrive systems, provided their proper use requires use of MoMan.

§ 3

Handover of MoMan

(1)	The copy of MoMan required to exercise the rights of use granted with this Contract is made available to the Licensee 
in digital, machine-readable form.

(2)	The Licensee also receives a copy of the user documentation in electronic form by means of downloading MoMan. This 
user documentation also contains the program description.

§ 4

Performance Limits

In particular, the following services by Faulhaber are not the subject of this Contract:

a)	 Installation of MoMan on the Licensee's premises;

b)	Individual setting of variable parameters of MoMan according to the Licensee's requirements (customizing);

c)	 Individual program extensions for the Licensee (individual modifications);

d)	Adjusting MoMan interfaces to the needs of the Licensee;

e)	Instructing and training the Licensee's program users;

f)	 Maintenance of MoMan, in particular the supply of new, subsequent program versions.

Licence Agreement7	
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§ 5

Licensee's claims in the event of deficiency in title

(1)	Faulhaber undertakes to assign MoMan free of third parties' rights, which stand in the way of contractual use of 
MoMan.

(2)	In the case that third parties claim such rights, the Licensee shall immediately notify Faulhaber of the claiming of such 
rights by third parties and shall issue Faulhaber with all legal powers and authorities necessary to defend Faulhaber 
against the rights claimed by third parties.

(3)	In this case (cf. No. (2)) Faulhaber is entitled at its own discretion,

a)	 to take suitable measures to remove the rights of third parties or their claim which impair contractual use of 
MoMan or 

b)	 to change or replace MoMan in such a way that the external rights of third parties are no longer breached, if 
and provided that this does not impair the guaranteed function of MoMan.

	 If Faulhaber does not succeed to do this within a reasonable period to be set by the Licensee, the Licensee is entitled 
to terminate the Licence Agreement without notice.

§ 6

Licensee's claims in the event of defects

(1)	Faulhaber and the Licensee agree that it is not possible to develop software programs so that they are error-free for 
all application conditions. Faulhaber guarantees the suitability of MoMan in the version made available for download-
ing according to Article 3 for the intended use according to Article 2 in compliance with the program description valid 
at the time the Contract was concluded, also made available for downloading. However, in the event that the Licensee 
combines MoMan with third party software, Faulhaber does not accept any defects liability for the compatibility of 
such third party software with MoMan.

(2)	In the event of substantial deviations from the program description, Faulhaber is obliged to make subsequent im-
provements. If Faulhaber does not success to remove or bypass the deviations through subsequent improvement 
within a reasonable period so that contractual use is made possible or if the subsequent improvement is to be deemed 
to have failed for other reasons, the Licensee is entitled to terminate the Licence Agreement without notice.

(3)	Claims due to defects expire within one year of downloading MoMan including the user documentation. The reduc-
tion in limitation period does not apply to cases of deliberate action.

§ 7

Liability, Compensation

(1)	Faulhaber is basically only liable in the event of intended use of MoMan by the Licensee in accordance with Article 2.

(2)	Faulhaber has unlimited liability for losses caused by deliberate intent or gross negligence. The same also applies to 
claims for culpably caused losses which cause fatal or physical injury, damage to health or are due to wilful conceal-
ment of a defect.

(3)	Faulhaber is liable in the cases of product liability according to the Product Liability Law.

(4)	Faulhaber is liable for losses caused by the breach of so-called “cardinal obligations”. Cardinal obligations are funda-
mental contractual duties which were decisive for conclusion of the Contract by the Licensee and which they could 
trust to be complied with. If Faulhaber has breached cardinal obligations due to slight negligence, the resulting liabil-
ity for compensation is limited to replacement of the foreseeable loss typical for the Contract.
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(5)	Faulhaber does not accept any liability for the loss or destruction of data unless this has been caused by gross neg-
ligence or deliberate breach of contractual or statutory duties. In the event of data loss on the Licensee's premises, 
Faulhaber is liable only up to the amount of the typical cost of restoring the data which is incurred despite regular 
data backup according to state of the art standards.

(6)	Otherwise any liability for compensation by Faulhaber is excluded, regardless of the legal reason.

(7)	Following termination of this Licence Agreement the Licensee is obliged to completely delete MoMan including the 
user documentation and any backup copies of MoMan.

§ 8

Closing Provisions

(1)	Changes or additions to this Contract shall be made in writing. If they do not satisfy this clause they are invalid. The 
same also applies to changes to this clause requiring the written form.

(2)	This Contract shall is subject to and shall be interpreted according to the laws of the Federal Republic of Germany with 
the exception of the CISG - United Nations Convention on Contracts for International Sale of Goods dated 11.04.1980.

(3)	The sole juridicial venue is Stuttgart, if the Licensee is a businessperson in the meaning of the Commercial Code, a 
legal person under public law or a public law special asset or on bringing the action the Licensee does not have any 
registered offices or usual place of residence (permanent address) in the Federal Republic of Germany.

(4)	Should a provision of this Contract be or become invalid, all other provisions shall remain unaffected. In such a case 
the Parties to the Contract are obliged to participate in creating provisions which best achieve the economic result of 
the invalid provisions in a legally valid way.
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